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Word 2010 

Tutorial 2: Editing and Formatting a Document 

A Guide to this Instructor’s Manual: 
We have designed this Instructor’s Manual to supplement and enhance your teaching experience 

through classroom activities and a cohesive chapter summary.  
 

This document is organized chronologically, using the same heading in blue that you see in the 

textbook. Under each heading you will find (in order): Lecture Notes that summarize the section, 

Figures and Boxes found in the section (if any), Teacher Tips, Classroom Activities, and Lab 

Activities. Pay special attention to teaching tips, and activities geared towards quizzing your 

students, enhancing their critical thinking skills, and encouraging experimentation within the 

software.  
 

In addition to this Instructor’s Manual, our Instructor’s Resources CD also contains PowerPoint 

Presentations, Test Banks, and other supplements to aid in your teaching experience.  

 

For your students:  
Our latest online feature, CourseCasts, is a library of weekly podcasts designed to keep your 

students up to date with the latest in technology news. Direct your students to 

http://coursecasts.course.com, where they can download the most recent CourseCast onto their 

mp3 player. Ken Baldauf, host of CourseCasts, is a faculty member of the Florida State University 

Computer Science Department where he is responsible for teaching technology classes to 

thousands of FSU students each year. Ken is an expert in the latest technology and sorts through 

and aggregates the most pertinent news and information for CourseCasts so your students can 

spend their time enjoying technology, rather than trying to figure it out. Open or close your 

lecture with a discussion based on the latest CourseCast. 
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Chapter Objectives 
Students will have mastered the material in this tutorial when they can: 

 

 Create bulleted and numbered lists 

 Move text within a document 

 Find and replace text 

 Check spelling and grammar 

 Format documents with themes and 

styles 

 Review the MLA style for research 

papers 

 Indent paragraphs 

 Insert and modify page numbers 

 Create citations and a bibliography 

 

WD 56 Revising a Document  

LECTURE NOTES 

 Demonstrate how to revise a document. 

 

BOXES 

 TIP: To reduce the gray space between pages to a gray line, double-click the gray space. To 

redisplay the gray space, double-click the gray line. (WD 57) 

 

FIGURES 

 Figure 2-1, Figure 2-2 

 

TEACHER TIP 

Explain to students that when they are revising a document, it is important that they save that document 

with a new name. 

 

Remind students that before they begin revising a document, they should familiarize themselves with the 

entire document and assess the revisions that need to be made. 

 

CLASSROOM ACTIVITIES 

1. Classroom Activity: Have the students open a previously saved Word document. You will ask them 

to make revisions to this document, but first remind them to save the file with a different name. 

Once they have done this, have them change the document’s font and font size. Have them 

change the heading so it is italicized and in bold. Remind them that they should save the 

document before closing it. 

2. Quick Quiz:  

 True/False: It is impossible to save a Word file with a name that is different from the one with 

which it was originally saved. (Answer: False) 
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 True/False: In a Word document, the gray space that separates pages always has to be 

displayed. (Answer: False) 

WD 58 Creating Bulleted and Numbered Lists  

LECTURE NOTES 

 Demonstrate how to create a bulleted list. 

 

BOXES 

 TIP: the Bullets button is a toggle button. To remove bullets from the selected text, click the 

Bullets button. (WD 59) 

 TIP: The numbering button is a toggle button which means you can click it to turn numbering on 

or off. To remove numbers from selected text, click the Numbering button. (WD 60) 

 

FIGURES 

 Figure 2-3, Figure 2-4 

 

TEACHER TIP 

Explain to students that if a paragraph is inserted, deleted, or reordered in a numbered list, Word 

automatically adjusts the numbers so they remain in a consecutive order. 

 

Point out to students that when a Word document is first opened, the default bullet style is the round 

bullet. Once they select a different bullet option, that bullet remains the default until it is changed. 

 

CLASSROOM ACTIVITIES 

1. Group Activity: Have the class works in groups of two. Have them click on the Bullets button in 

the Paragraph group on the Home tab. Have them preview the options listed under the Bullets 

button and discuss how each bullet could be used appropriately. 

2. Quick Quiz: 

 A __________ _____ is a group of related paragraphs with a special symbol, such as a dot, 

dash, or other character, that appears to the left of each paragraph. (Answer: B) 

A. Bullets button 

B. Bulleted list 

C. Numbers list 

D. paragraph format 

 True/False: To create a numbered list, you can use the Numbering button in the Paragraph 

group. (Answer: True) 

 

LAB ACTIVITY: 

Have students break off into pairs. They will work together to create two lists: one bulleted list and 

one numbered list. Tell them that the bulleted list will be used as a checklist for a family who is 

moving and that the numbered list will include the step-by-step directions to their new house. Have 

them share their creations with the class. 
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WD 60 Moving Text in a Document 

LECTURE NOTES 

 Demonstrate how to move text in a document. 

 

BOXES 

 REFERENCE: Cutting (or Copying) and Pasting Text (WD 63) 

 TIP: You can also press Ctrl+X to cut selected text, and press Ctrl+V to paste the most recent 

copied item. (WD 63) 

 TIP: You can also copy selected text by pressing Ctrl+C. (WD 65) 

 TIP: To select a paste option before pasting an item, click the Paste button arrow in the Clipboard 

group on the Home tab, and then click the paste option you want. (WD 66) 

 

FIGURES 

 Figure 2-5, Figure 2-6, Figure 2-7, Figure 2-8, Figure 2-9, Figure 2-10 

 

TEACHER TIP 

Point out to students that Word provides several ways to move text: drag and drop, cut and paste, and 

copy and paste. 

 

Explain to students that the Clipboard is only a temporary storage area on their computer that holds text 

or graphics, and that if text or graphics are cut from a document, they are automatically put onto the 

Clipboard. 

 

CLASSROOM ACTIVITIES 

1. Group Activity: Have the class open up a previously saved Word document. Explain to students 

that they will practice moving text using the drag and drop, cut and paste, and copy and paste 

methods. When they are finished, have them share with the class the method that they prefer 

and why.  

2. Quick Quiz:  

 True/False: The Clipboard task pane displays the contents of the Clipboard. (Answer: True) 

 To _________ means to insert a copy of whatever is on the Clipboard into a document. 

(Answer: C) 

A. Copy 

B. Clipboard 

C. Paste 

D. format 

WD 67 Finding and Replacing Text 

LECTURE NOTES 

 Demonstrate how to find and replace text. 

 

BOXES 

 REFERENCE: Finding and Replacing Text (WD 68) 

 INSIGHT: Searching for Formatting (WD 71) 
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FIGURES 

 Figure 2-11, Figure 2-12 

 

TEACHER TIP 

Remind students that the Navigation Pane can be used to search for particular items in a document. 

 

Point out to students that the Find and Replace dialog box can be used to locate an item in a document 

and then replace it with something else. 

 

CLASSROOM ACTIVITIES 

1. Class Discussion: Have the class discuss different scenarios in which the Find and Replace dialog 

box might be useful. Why might you need to replace one word with another? Have the class give 

specific examples of their findings.   

2. Quick Quiz:  

 True/False: A search result is a list that contains each instance of the item that was searched. 

(Answer: True) 

 The _____________ provide(s) options for finding a specific word or phrase in the document 

and replacing it with another word or phrase. (Answer: D) 

A. Search text 

B. Go To Tab 

C. Search results 

D. Replace tab 

WD 71 Using the Spelling and Grammar Checker 

LECTURE NOTES 

 Demonstrate how to use the Spelling and Grammar Checker. 

 

BOXES 

 REFERENCE: Checking a Document for Spelling and Grammar Errors (WD 71) 

 TIP: If you want to check only for spelling errors, you can deselect the Check grammar check 

box. (WD 72) 

 PROSKILLS: Written Communication: Proofreading Your Document (WD 73) 

 

FIGURES 

 Figure 2-13 

 

TEACHER TIP 

Point out to students that when using the Spelling and Grammar checker, they have the option to check 

the document for spelling errors only. Checking for grammatical errors is optional. 
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Remind students that another way to check for spelling and grammatical errors is by using the 

AutoCorrect feature, about which they have previously learned. Remind them that possible text errors 

will be marked with a wavy line.  

 

CLASSROOM ACTIVITIES 

1. Group Activity: Have the class open up a previously saved Word document on their own 

computers. Have them scan the document looking for any text underlined with a wavy line. Then 

have them use the Spelling and Grammar Checker. First have them check for spelling errors only. 

Then have them check for grammatical errors. When they are finished have them discuss which 

method they prefer and why. 

2. Quick Quiz:  

 True/False: The Spelling and Grammar Checker checks a document word by word for a 

variety of errors. (Answer: True) 

 True/False: The Spelling and Grammar Checker will catch every grammatical error. (Answer: 

False. That is why it is imperative to proofread a document as well.) 

WD 73 Working with Styles 

LECTURE NOTES 

 Demonstrate how to apply and work with styles. 

 

BOXES 

 TIP: On most computers, you can press the F4 key to repeat your most recent action. (WD 75) 

 INSIGHT: Understanding the Benefits of Styles (WD 76)  

 

FIGURES 

 Figure 2-14, Figure 2-15, Figure 2-16  

 

TEACHER TIP 

Point out to students that style names reflect the use for that particular style. 

 

Explain to students that they can choose between styles that format whole paragraphs and styles that 

format individual characters. 

 

CLASSROOM ACTIVITIES 

1. Quick Quiz: 

 True/False: Style and Quick Style refer to the same thing. (Answer: True) 

 True/False: Character-level formatting is used when only a few characters or words need to 

be formatted. (Answer: True)  

2. Group Activity: Have the class work at their computers and open up a previously saved Word 

document. Have them format their document by applying Spacing, Heading, and paragraph-level 

formatting to the entire document. After they do this, have them go back and apply character-level 

formatting to just a few words.  
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WD 76 Working with Themes 

LECTURE NOTES 

 Demonstrate how to apply themes. 

 

 

FIGURES 

 Figure 2-17, Figure 2-18, Figure 2-19 

 

TEACHER TIP 

Point out to students that the forty-four different themes included in Word offer a coordinating 

assortment of fonts, colors, and text effects. 

 

Remind students that when they open up a blank Word document, the Office theme is applied by 

default. 

 

CLASSROOM ACTIVITIES 

1. Group Activity: Have students work at their own computers and open a previously saved Word 

document. Have them apply a theme to their document, paying attention to the fonts, colors, and 

text effects used. Have them share with the class the theme they chose and why; discuss the 

theme’s design style.  

2. Quick Quiz: 

 The ________ ______ controls the variety of fonts, colors, and other visual effects available as 

a document is formatted. (Answer: A) 

A. document theme 

B. color palette 

C. theme color 

D. Office theme 

 True/False: In a theme, the same font is never assigned to both the heading and the body of 

the text. (Answer: False) 

3. Critical Thinking: Have the class break off into pairs and click the Themes button located in the 

Themes group on the Page Layout tab. Have them discuss with their partner the various themes 

available and for what they might be used. Have them choose their favorite theme and discuss the 

font, color, and text effects offered in that theme. Do these choices seem appropriate? Would they 

have chosen a different font? Color? Text effect? 

 

LAB ACTIVITY 

Have students design their own theme. They will create a one-page document designed as a flyer. 

This flyer will be used as an advertisement for guitar lessons that they will provide. They will want to 

include a few paragraphs on their history with the instrument, the style of music they teach, and 

their years of experiences. They can insert graphics, photos, and bulleted or numbered lists. They will 

want to choose fonts, font styles, text effects, and colors. Have them share their flyer with the rest of 

the class and explain why they chose the various elements.  
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WD 82 Reviewing the MLA Style 

LECTURE NOTES 

 Explain the MLA style. 

BOXES 

 INSIGHT: Formatting an MLA-Style Research Paper (WD 82) 

 

FIGURES 

 Figure 2-20  

 

TEACHER TIP 

Explain to students that people in different fields use different style guides, with each style guide 

designed to suit the needs of a specific discipline. 

 

Point out that the Modern Language Association (MLA) style is widely used in the humanities field. 

 

CLASSROOM ACTIVITIES 

1. Quick Quiz: 

 True/False: A style guide is a set of rules that describe the preferred format and style for a 

certain type of writing. (Answer: True)  

 True/False: The guidelines for a specific style guide focus on specifications for formatting. 

(Answer: True) 

2. Group Activity: Have students open up a blank Word document and have them format that 

document to match the MLA style. They should use Figure 2-20 as a reference. They will double 

space, remove paragraph spacing, and increase the font size to 12 points for the entire document. 

(Note: they will address the last two bullet points in Figure 2-20 in the next section.) Make sure they 

save the document so it can be opened up at a later time. 

3. Critical Thinking: Have students discuss, in groups of three, the MLA style and the APA style. 

Have they used either of these style guides in any paper they have written? Have they read a paper 

written in either of these styles? Have students discuss why certain style guides are better suited to 

one field than another. Are there other style guides that they have used to write a paper or that were 

used in a paper they read? What differentiated those styles from these styles? What are the pros and 

cons of each style? Which style guide do they prefer to use and why? 

WD 83 Indenting a Paragraph 

LECTURE NOTES 

 Discuss how to indent paragraphs. 

 

BOXES: 

 TIP: You can also click in the paragraph you want to indent or select multiple paragraphs, click 

the Dialog Box Launcher in the Paragraph group, and then adjust the Indentation settings. (WD 

84) 

 

FIGURES 

 Figure 2-21, Figure 2-22 
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TEACHER TIP 

Explain to students that Word offers a number of options for indenting a paragraph, including indenting 

an entire paragraph or just indenting one line of the paragraph. 

 

Point out to students that when indenting a paragraph using the Increase Indent button, the paragraph 

indents in increments of .5 inches. 

CLASSROOM ACTIVITIES 

1. Quick Quiz: 

 True/False: A Hanging indent is where all lines except the first line of the paragraph are 

indented from the right margin. (Answer: False. It is when it is indented from the left 

margin.) 

 True/False: When using the Increase Indent or Decrease Indent buttons, the paragraph will 

increase or decrease in increments of 0.5 inches. (Answer: True) 

2. Group Activity: Have students open up the Word document they had previously formatted using 

the MLA style. Have them continue formatting the document in the MLA style by indenting the 

first line of each paragraph .5 inches from the left margin. Make sure they save the document 

with the changes they just made. 

WD 86 Inserting and Modifying Page Numbers 

LECTURE NOTES 

 Demonstrate how to insert and modify page numbers. 

 

BOXES 

 TIP: To remove page numbers from a document, click the Remove Page Numbers command on 

the Page Number menu. (WD 86) 

 TIP: After you insert a page number in a document, you can always reopen Header and Footer 

view by double-clicking the page number in Print Layout view. (WD 88) 

 

FIGURES 

 Figure 2-23, Figure 2-24  

 

TEACHER TIP 

Explain to students that, in order to number their pages, they do not have to type a page number on each 

page. Instead they can insert a page number field which instructs Word to do it for them. 

 

Point out to students that when using the MLA style, it requires that they use a page number preceded by 

the person’s last name in the upper –right-hand corner of each page. 
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CLASSROOM ACTIVITIES 

1. Quick Quiz: 

 The ____________ is the blank area above the top margin. (Answer: header) 

 True/False: The page number field is an instruction that tells Word to insert a page number 

on each page. (Answer: True) 

2. Group Activity: Have the class open up their MLA style Word document. Now have them add the 

page number (preceded by their last name) in the upper-right corner of each page. If they prefer, 

they can omit this from the first page. When they finish, have them refer back to Figure 2-20 to 

double check that they have formatted their document with an MLA style, correctly. 

WD 88 Creating Citations and a Bibliography 

LECTURE NOTES 

 Demonstrate how to create citations and a bibliography. 

 

BOXES 

 PROSKILLS: Written Communication: Acknowledging You Sources (WD 89) 

 REFERENCE: Creating Citations (WD 90) 

 TIP: To delete a citation, click the citation to display the content control, click the tab on the left 

side of the content control, and then press the Delete key. (WD 92) 

 TIP: To insert a new, blank page in the middle of a document, position the insertion point where 

you want to insert the blank page, and then click the Blank Page button in the Pages group on 

the Insert tab. (WD 95) 

 INSIGHT: Managing Sources (WD 97) 

 

FIGURES 

 Figure 2-25, Figure 2-26, Figure 2-27, Figure 2-28, Figure 2-29, Figure 2-30, Figure 2-31, Figure 

2-32, Figure 2-33 

 

TEACHER TIP 

Explain to students that for every citation inserted in a document, there is a corresponding entry in the 

list of works cited or bibliography. 

 

Point out to students that, although some style guides are very rigid about the form and location of 

citations, the MLA style is quite a bit more flexible. 
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CLASSROOM ACTIVITIES 

1. Quick Quiz: 

 An alphabetical list of all books, magazines, web sites, movies, and other works that are 

referred to in a research paper is called the ______________. (Answer: bibliography) 

 True/False: A citation should be used every time someone is quoted or a source is referred to 

in a document. (Answer: True)  

2. Group Activity: Have students break off into groups of three and have them discuss a document 

they have written. What was the purpose of the document? For what field of business was the 

document written? What style guide was used? What were some of the sources cited in the 

bibliography? 

 

LAB ACTIVITY 

Have students open their previously formatted MLA Word document. Have them insert parenthetical 

references or citations throughout their document, using a specified style of their choosing. (They can 

make up sources and quotes for the purpose of this exercise.) Have them create a bibliography at the end 

referencing those citations, using a specified style of their choosing. When they have finished, have 

students compare their citations and bibliographies and their style choices. 

WD 98 Finalizing an MLA Works Cited List  

LECTURE NOTES 

 Demonstrate how to finalize a works cited list to match the MLA style. 

 

BOXES 

 TIP: After you convert a bibliography to static text, you can no longer update it to reflect changes 

to the document citations. So don’t convert it until the bibliography contains all the necessary 

information. (WD 99) 

 

FIGURES 

 Figure 2-34, Figure 2-35, Figure 2-36, Figure 2-37, Figure 2-38 

 

TEACHER TIP 

Remind students that they will need to adapt the bibliography in their Word document to match the 

MLA guidelines. 

 

Point out to students that before they finalize their works cited list to match the MLA style, they will 

want to convert the list from a field that can be updated automatically to static text, which is text that 

cannot be updated automatically. 

 

CLASSROOM ACTIVITIES 

1. Group Activity: Have students open up their MLA styled Word document and adapt the 

bibliography to match the works cited list MLA guidelines. Make sure they are formatting the 

bibliography to match the rest of the text in the document. They will want to center the title of 

the Works Cited list. Have them refer to Figure 2-34 and have them use it as a step-by-step guide 

for this exercise. 



New Perspectives on Word 2010 Instructor’s Manual 12 of 13 

 

2. Quick Quiz: 

 What is static text? (Answer: Text that cannot be updated automatically) 

 True/False: Word inserts a bibliography, or works cited list, in a content control. (Answer: 

True) 

End of Tutorial Material 

 Review Assignments: Review Assignments provide students with additional practice of the skills they 

learned in the tutorial using the same tutorial case, with which they are already familiar. These 

assignments are designed as straight practice only and should not include anything of an exploratory 

nature. 

 

 Case Problems: A typical NP tutorial has four Case Problems following the Review Assignments. Short 

tutorials can have fewer Case Problems (or none at all); other tutorials may have five Case Problems. 

The Case Problems provide further hands-on assessment of the skills and topics presented in the 

tutorial, but with new case scenarios. There are four types of Case Problems:  

 Apply. In this type of Case Problem, students apply the skills that they have learned in the tutorial 

to solve a problem. Apply Case Problems can include Explore steps, which go a bit beyond what 

was presented in the tutorial, but should include only one or two Explore steps if any at all.  

 Create. In a Create Case Problem, students are either shown the end result, such as a finished Word 

document, and asked to create the document based on the figure provided; or, students are asked 

to create something from scratch in a more free-form manner.  

 Challenge. A Challenge Case problem involves three or more Explore steps. These steps challenge 

students by having them go beyond what was covered in the tutorial, either with guidance in the 

step or by using online Help as directed.  

 Research. In this type of Case Problem, students need to go to the Web to find information that 

they will incorporate in their work for the Case Problem.  

A tutorial does not have to include each of the four types of Case Problems; rather, the tutorial’s 

content should dictate which Case Problems to include. It’s possible, therefore, that some tutorials 

might have three Case Problems of one type and only one Case Problem of a different type. To the 

extent possible, the first Case Problem in a tutorial should be an Apply so that the Case Problems 

progress in degree of difficulty. 

 

 Internet Assignments: Internet Assignments are additional exercises that students access via the Student 

Online Companion Web site. These assignments integrate the skills the students learned in the 

tutorial with research on the Web. Not all books or tutorials include Internet Assignments; for 

example, in the Office First Course text, only the application tutorials (Word, Excel, Access, and 

PowerPoint) have Internet Assignments. 

 

 ProSkills Exercises: This feature is new for Office 2010 and Windows 7. ProSkills exercises integrate the 

technology skills students learn with one or more of the following soft skills: decision-making, 

problem-solving, teamwork, verbal communication, and written communication. The goal of these 

exercises is to enhance students’ understanding of the soft skills and how to apply them appropriately 

in real-world, professional situations that also involve software application skills. ProSkills exercises 
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are offered at various points throughout a text, encompassing the concepts and skills presented in a 

standalone tutorial or a group of related tutorials. 

Glossary of Key Terms 

 American Psychological Association (APA) 

(WD 82) 

 Bibliography (list of works cited) (WD 88) 

 bullet (WD 54) 

 bulleted list (WD 58) 

 character-level formatting (WD 74) 

 citations (WD 82) 

 Clipboard (WD 62) 

 Clipboard task pane (WD 63) 

 content control (WD 81) 

 copy (WD62) 

 cut (WD 62) 

 drag and drop (WD 61) 

 field (WD 95) 

 Find and Replace dialog box (WD 67) 

 First Line Indent marker (WD 84) 

 Footer (WD 86) 

 hanging indent (WD 83) 

 Hanging Indent marker (WD 84) 

 header (WD 86) 

 Left Indent marker (WD 84) 

 Manual page break (WD 95) 

 Modern Language Association (MLA) (WD 82) 

 Navigation Pane (WD 54) 

 numbered list (WD58) 

 page number field (WD 86) 

 paste (WD 62) 

 paragraph-level formatting (WD 73) 

 Right Indent marker (WD 84) 

 search results (WD 67) 

 search text (WD 68) 

 sources (WD 88) 

 Spelling and Grammar checker (WD 71) 

 Style guide (WD 82) 

 Style (Quick Style) (WD 73) 

 theme (WD 76) 
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